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Introduction

IBM® Predictive Maintenance and Quality uses data from multiple sources to give
you the information that you need to make informed operational, maintenance,
repair, or component replacement decisions.

IBM Predictive Maintenance and Quality provides you with operational
intelligence data, which enables you to:
v Understand, monitor, predict, and control product and process variability
v Perform in-depth root cause failure analysis
v Identify incorrect operating practices
v Enhance equipment and process diagnostics capabilities

It also provides you with asset performance management capabilities that enable
you to:
v Have forward visibility into equipment and process performance
v Increase asset uptime
v Identify safety issues
v Identify improper maintenance procedures
v Optimize maintenance intervals and procedures.

Audience

This document is intended to help users install Predictive Maintenance and
Quality.

Finding information

To find IBM Predictive Maintenance and Quality product documentation on the
web, go to the IBM Predictive Maintenance and Quality information center
(http://pic.dhe.ibm.com/infocenter/pmq/v1r0m0/index.jsp).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components included in the IBM Predictive Maintenance and Quality solution have
accessibility features.

IBM Predictive Maintenance and Quality HTML documentation has accessibility
features. PDF documents are supplemental and, as such, include no added
accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

© Copyright IBM Corp. 2013 v
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Chapter 1. IBM Predictive Maintenance and Quality

With IBM Predictive Maintenance and Quality, you can monitor, analyze, and
report on information that is gathered from devices. In addition, recommendations
for actions can be generated by IBM Predictive Maintenance and Quality.

IBM Predictive Maintenance and Quality is an integrated solution that you can use
to perform the following tasks:
v Predict the failure of an instrumented asset so that you can prevent costly

unexpected downtime.
v Quickly mine maintenance logs to determine the most effective repair

procedures and maintenance cycles.
v Identify the root cause of asset failure faster so that you can take corrective

actions.

Instrumented assets generate data such as device ID, timestamp, temperature, and
status code. This data can be collected and used in models that predict when an
asset is likely to fail.

Examples of instrumented assets are manufacturing equipment, mining equipment,
drilling equipment, farming equipment, security equipment, cars, trucks, trains,
helicopters, engines, cranes, oil platforms, and wind turbines.

For example, an oil refinery is a system that combines thousands of interlocking
pieces. It is critical that such a system is able to work safely and efficiently. You
can use IBM Predictive Maintenance and Quality to monitor and track the lifecycle
of each piece of the refinery, such as each pipe, pump, compressor, valve, furnace,
turbine, tank, heat exchange unit, and boiler. Reports give you the information to
ensure that you have the right parts available and can schedule repairs during
downtimes.

Predictive maintenance

In predictive maintenance, you look for patterns in the usage and environmental
information for equipment that correlate with failures that take place. This
information is used to create predictive models to score incoming new data. You
can predict the likelihood of failure. Scores are generated from this information
that give you an indication of the health of the piece of equipment. In addition,
key performance indicators (KPIs) are collected, which are used for reporting. KPIs
help you to identify assets that do not conform to normal patterns of behavior. You
can define rules to generate recommendations when a piece of equipment is
identified as having a high probability of failure. Recommendations can be fed into
other systems so that people are alerted to them automatically.

Predictive quality in manufacturing

Past operations data, environmental data, and historical defect data can be used to
identify the causes of elevated defect rates. This information is used in predictive
models, so that when incoming data is fed into the models, you can predict the
likely defect rates. The predicted values are then used for analysis and reporting
and to drive recommendations such as modification to inspection patterns, or
recalibration of machinery. Scoring can be done on a near real-time basis.

© Copyright IBM Corp. 2013 1



Solution architecture
The IBM Predictive Maintenance and Quality solution is divided into nodes, where
each node provides a specific function for the solution. Each node must be
installed on a separate computer or on a separate virtual machine image from
other nodes.

For a complete list of products included with Predictive Maintenance and Quality,
see Appendix B, “Products installed with IBM Predictive Maintenance and
Quality,” on page 53.

The following diagram shows the nodes.

Predictive Analytics node

The Analytics node in provides predictive scores and offers recommendations.

This node has the following software installed:
v IBM WebSphere® Network Deployment
v IBM SPSS® Collaboration and Deployment Services
v IBM SPSS Modeler Server
v IBM SPSS Data Access Pack
v IBM SPSS Text Analytics Server
v IBM SPSS Modeler Collaboration and Deployment Services Adapter
v IBM SPSS Decision Management
v IBM SPSS Statistics Server
v IBM SPSS Statistics Collaboration and Deployment Services Adapter

Figure 1. Predictive Maintenance and Quality nodes
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v IBM DB2® Client

Business Intelligence (BI) node

The BI node provides dashboards and reports.

This node has the following software installed:
v IBM WebSphere Network Deployment
v IBM HTTP Server
v IBM Cognos® Business Intelligence
v IBM DB2 Client

Enterprise Service Bus (ESB) node

The ESB node server processes events, updates the content for IBM Cognos
Business Intelligence, and triggers predictive scoring and decision management. It
also loads master data into the solution.

This node has the following software installed:
v IBM WebSphere Message Queue
v IBM WebSphere Message Broker
v IBM WebSphere Message Broker Explorer
v IBM WebSphere Message Broker ODBC Database Extender

Master Data Management (MDM) node

The MDM node manages the master data for the solution. The master data
includes the set of devices that supply events to the solution and their locations. It
also includes metadata that is used to determine how events are processed by the
solution.

This node has the following software installed:
v IBM WebSphere Network Deployment
v IBM InfoSphere® Master Data Management Collaboration Edition
v IBM DB2 Client

Data node

The Data node provides the database server that contains the databases that are
used by other products in the solution. The database acts as an event store and
holds calculated key performance indicators (KPIs) and profiles. It also contains
supporting master data for the solution.

This node has the following software installed:
v IBM DB2 Enterprise Server Edition

Chapter 1. IBM Predictive Maintenance and Quality 3



4 IBM Predictive Maintenance and Quality Version 1.0: Installation Guide



Chapter 2. Installation planning and preparation

Before you install IBM Predictive Maintenance and Quality, ensure that the
computers that you use meet the minimum requirements for operating systems,
prerequisite software, processing, and disk space.

You must also install additional prerequisite software on some computers,
including the Business Intelligence (BI) node, the Master Data Management (MDM)
node, and the Enterprise Service Bus (ESB) node computers.

Important: The computers or virtual machines that you use for Predictive
Maintenance and Quality nodes must not have any of the included software
already installed.

Critical installation and configuration issues

To review a list of critical installation and configuration issues for IBM Predictive
Maintenance and Quality version 1.0 as of the date of release, see the document
titled Critical installation and configuration issues for IBM Predictive Maintenance
and Quality version 1.0 (http://www.ibm.com/support/
docview.wss?uid=swg21637185).

Supported operating systems and hardware requirements
Review the minimum hardware and operating system requirements before you
install IBM Predictive Maintenance and Quality. The requirements apply for all
computers or virtual machines that you use for the installation.

Server computers

The IBM Predictive Maintenance and Quality server components must be installed
on computers that are running the 64-bit Red Hat Enterprise Linux Server Edition
version 6.3 (x86_64) operating system.

You must have the Legacy UNIX compatibility package installed. The package is
selected when the operating system is set up. The components of this package
must be installed on each computer or virtual machine image on which you install
a Predictive Maintenance and Quality node.

Hardware requirements

At a minimum, each computer or virtual machine that is hosting a
Predictive Maintenance and Quality server component, or node, must have
the following hardware requirements:
v 4 processors
v 8 GB of RAM
v 500 GB of hard disk space

Each node must be installed on a separate computer or on a separate
virtual machine image.

User requirements

© Copyright IBM Corp. 2013 5
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You must have root access to all of the computers on which you install a
Predictive Maintenance and Quality node. Each computer on which you
install a node must have remote root log in enabled.

You must log in to the computer where you run the installer as root.

Client computers

The Predictive Maintenance and Quality client components must be installed on
computers that are running Microsoft Windows 7 64-bit operating systems.

Ensuring that the required operating system packages are
installed

Specific operating system packages must be installed on each computer or virtual
machine where you install an IBM Predictive Maintenance and Quality node.

Ensure that the following packages are installed:
v libXext-1.1-3.el6.i686.rpm

v libXft-2.1.13-4.1.el6.i686.rpm

v libXi-1.3-3.el6.i686.rpm

v libXp-1.0.0-15.1.el6.i686.rpm

v libXpm-3.5.8-2.el6.i686.rpm

v libXrender-0.9.5-1.el6.i686.rpm

v libXtst-1.0.99.2-3.el6.i686.rpm

v compat-libstdc++-33-3.2.3-69.el6.i686.rpm

v compat-libstdc++-296-2.96-144.el6.i686.rpm

v expat-2.0.1-11.el6_2.i686.rpm

v fontconfig-2.8.0-3.el6.i686.rpm

v freetype-2.3.11-6.el6_2.9.i686.rpm

v libstdc++-4.4.6-4.el6.i686.rpm

v libX11-1.3-2.el6.i686.rpm

v libXau-1.0.5-1.el6.i686.rpm

v libxcb-1.5-1.el6.i686.rpm

v libICE-1.0.6-1.el6.i686.rpm

v libuuid-2.17.2-12.7.el6.i686.rpm

v libSM-1.1.0-7.1.el6.i686.rpm

v libXt-1.0.7-1.el6.i686.rpm

v libXmu-1.0.5-1.el6.i686.rpm

v libjpeg-6b-46.el6.i686.rpm

v libpng-1.2.49-1.el6_2.i686.rpm

v zlib-1.2.3-27.el6.i686.rpm

v glibc-2.12-1.80.el6.i686.rpm

v openmotif-2.3.3-4.el6.i686.rpm

Procedure
1. Log in as root.
2. Type the following command to verify that an operating system package is

installed:
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rpm -qi full_package_name

For example, to verify that libXext-1.1-3.el6.i686 is installed, type rpm -qi
libXext-1.1-3.el6.i686.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install libXext-1.1-3.el6.i686, type rpm -ihv
libXext-1.1-3.el6.i686.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Verifying that the Legacy UNIX compatibility package is
installed

Legacy UNIX compatibility must be installed on each computer or virtual machine
where you install an IBM Predictive Maintenance and Quality node.

You must verify that the following packages are installed:
v authd-1.4.3-30.el6.x86_64.rpm

v cups-lpd-1.4.2-48.el6.x86_64.rpm

v dump-0.4-0.6.b42.el6.x86_64.rpm

v finger-0.17-39.el6.x86_64.rpm

v finger-server-0.17-39.el6.x86_64.rpm

v krb5-appl-servers-1.0.1-7.el6_2.1.x86_64.rpm

v ksh-20100621-16.el6.x86_64.rpm

v mksh-39-7.el6.x86_64.rpm

v ncompress-4.2.4-54.el6_2.1.x86_64.rpm

v rsh-0.17-60.el6.x86_64.rpm

v rsh-server-0.17-60.el6.x86_64.rpm

v rusers-0.17-61.el6.x86_64.rpm

v rusers-server-0.17-61.el6.x86_64.rpm

v rwho-0.17-34.el6.x86_64.rpm

v talk-0.17-34.el6.x86_64.rpm

v talk-server-0.17-34.el6.x86_64.rpm

v tcp_wrappers-7.6-57.el6.x86_64.rpm

v telnet-0.17-47.el6.x86_64.rpm

v telnet-server-0.17-47.el6.x86_64.rpm

v tftp-0.49-7.el6.x86_64.rpm

v xinetd-2.3.14-34.el6.x86_64.rpm

Procedure
1. Log in as root.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that authd-1.4.3-30.el6.x86_64 is installed, type rpm
-qi authd-1.4.3-30.el6.x86_64.
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3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install authd-1.4.3-30.el6.x86_64, type rpm -ihv
authd-1.4.3-30.el6.x86_64.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Installing prerequisite operating system packages on the BI
node computer

Specific operating system packages must be installed on the Business Intelligence
(BI) node computer or virtual machine before you install IBM Predictive
Maintenance and Quality.

The following packages must be installed:
v libselinux-2.0.94-5.3.el6.i686.rpm

v cracklib-2.8.16-4.el6.i686.rpm

v db4-4.7.25-17.el6.i686.rpm

v audit-libs-2.2-2.el6.i686.rpm

v pam-1.1.1-13.el6.i686.rpm

Procedure
1. Log in to the BI node computer as root.
2. Type the following command to verify that an operating system package is

installed:
rpm -qi full_package_name

For example, to verify that libselinux-2.0.94-5.3.el6.i686 is installed, type
rpm -qi libselinux-2.0.94-5.3.el6.i686.

3. Install any package that is not already installed.
You must download any missing package, and then install the downloaded
package by typing the following command:
rpm -ihv full_package_name.rpm

For example, to install libselinux-2.0.94-5.3.el6.i686, type rpm -ihv
libselinux-2.0.94-5.3.el6.i686.rpm.

Important: To install pam-1.1.1-13.el6.i686.rpm, use the following command:
rpm --force -ivh pam-1.1.1-13.el6.i686.rpm.

Installation of Perl on the MDM node computer
You must install a version of Perl on the Master Data Management (MDM) node
computer for IBM Predictive Maintenance and Quality.

In the Deployment Wizard, you are prompted for a location on the MDM node
computer where you installed Perl.

For more information about installing Perl for IBM InfoSphere Master Data
Management, see the MDM documentation(pic.dhe.ibm.com/infocenter/mdm/
v10r1/index.jsp?topic=%2Fcom.ibm.pim.ins.doc%2Fpim_tsk_installingperl.html).
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Note: For IBM Predictive Maintenance and Quality, the minimum version of Perl
is 5.10.

Installing IBM Data Server Driver on the ESB node computer
Before you can deploy IBM Predictive Maintenance and Quality, you must install
the IBM Data Server Driver for ODBC and CLI on the Enterprise Service Bus (ESB)
node computer.

Procedure
1. Go to the IBM driver and client download page (www.ibm.com/support/

docview.wss?uid=swg21385217).
2. Click the link for IBM Data Server Driver for ODBC and CLI (CLI Driver).
3. If prompted, log in with your IBM account.
4. Select IBM Data Server Driver for ODBC and CLI (Linux AMD64 and Intel

EM64T).
5. Click Continue, and download the driver.
6. Go to the directory where you downloaded the driver.
7. Type the following command to extract the files:

tar -zxf ibm_data_server_driver_for_odbc_cli_linuxx64_v10.1.tar.gz

The files are extracted to the odbc_cli/clidriver directory.
8. Copy the odbc_cli directory to the var directory to match the default location

in the server installer. For example, ensure the path is /var/odbc_cli.

Disabling SELinux on all target computers
You must disable the Security-Enhanced Linux (SELinux) feature on all computers
where you install an IBM Predictive Maintenance and Quality node.

Procedure
1. Log in as root.
2. Go to the /etc/sysconfig directory.
3. Type sestatus to verify that the SELinux feature is disabled.
4. If the SELinux feature is not disabled, open the selinux file for editing.
5. Change the SELINUX value to disabled.

For example, the file should include:
SELINUX=disabled

6. Save and close the file.
7. Restart the computer for the changes to take effect.
8. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node.

Computer firewall settings required for the installation
The Deployment Wizard requires bidirectional communication with each IBM
Predictive Maintenance and Quality node when you install a server component or
server artifact component, and your firewall can interfere with this communication.
To unsure this communication, you must configure your firewall settings for the
installation.
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Configuring your firewall settings for the Deployment Wizard
On each computer on which you will install an IBM Predictive Maintenance and
Quality node, you must open two ports to allow the bidirectional communication
that is required by the Deployment Wizard. After you open the ports in your
firewall, you can then enter these port values in the Deployment Wizard.

Procedure
1. Log in as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the two ports that are required by the Deployment Wizard with
the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 35000 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 30000 -j ACCEPT

Where port 35000 and 30000 are available port numbers on your computers.
You do not have to use these port numbers, but you must use available port
numbers.
If you do not use ports 35000 and 30000, ensure that you change only the port
number values in the commands.

Tip: Using the same port numbers for each target computer is recommended.
4. Type the following command to save your firewall settings:

/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node, and on the computer from where you run the
installation if it is not one of the node computers.

Configuring your firewall settings for the Data node
installation and configuration

Before you can install and configure the IBM Predictive Maintenance and Quality
Data node, you must ensure that the database server port number is open on the
Data node computer.

Procedure
1. Log in to the Data node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the port with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 50000, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50000 -j ACCEPT

Note: If you are using a port number other than 50000 for your database
server, ensure you open the appropriate port number.
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4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Disabling your computer's firewall during the installation
If you choose to temporarily disable your computer's firewall during the
installation of IBM Predictive Maintenance and Quality, ensure that you enable the
firewall on each node after the installation is complete.

Important: If you disable your computer's firewall during the installation, you
must still ensure that the required ports are opened on each node computer when
you restart your firewall.

Procedure
1. Log in as the root user.
2. Go to the /etc/init.d directory.
3. Type the following command:

iptables stop

4. Repeat these steps on each computer on which you install a node and on the
server from which you are running the installation.

What to do next

After the installation is complete, on each node, go to the /etc/init.d directory,
and type iptables start to restart your firewall.

Mounting the USB hard disk drive
The installation files for IBM Predictive Maintenance and Quality are provided on
a universal serial bus (USB) hard disk drive. You can run the installation from the
USB or you can copy the files to your computer before you start the installation.
Before you do either, you must mount the USB hard disk drive.

For more information about mounting USB hard disk drives, see the Red Hat
Customer Portal (https://access.redhat.com/home).

Verifying that your servers prerequisites are met
Scripts are provided to help you ensure that the computers on which you install an
IBM Predictive Maintenance and Quality node meet the minimum requirements.

The following scripts are provided:

CheckPkg.sh
Verifies that the required rpm packages are installed on the computer. The
rpm names are listed in the packages.lst file.

CheckDB2.sh
Verifies the version, installation location, instance name, and status of an
existing IBM DB2 server.
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CheckPaf.sh
Verifies the operating system, disk space, memory, and number of
processors for computer.

checkport.sh
Verifies that a port is open on the computer firewall. For example, on the
Data node computer, type ./checkport.sh 50000 to ensure that port 50000
is open on that computer.

CheckRemotePort.sh
Verifies that a port is open on a remote computer's firewall. For example,
to verify that the database server port number is open on the Data node
computer, type ./CheckRemotePort.sh data_node_name 50000 to ensure that
port 50000 is open on that computer. data_node_name can be the fully
qualified domain name or IP address of the Data node computer.

CheckUser.sh
Verifies that the current user is root.

CheckWAS.sh
Tests if WebSphere Application Server is installed on a node computer. If
installed, the version, build level and date, and installation location are
displayed.

Procedure
1. In a terminal window, go to the USB hard disk drive that you mounted or to

the directory where you copied the installation files.
2. In a terminal window, go to the USB hard disk drive that you mounted or to

the directory where you copied the installation files.
3. Go to the Prerequisite Checker directory.
4. Copy the scripts to each computer on which you want to verify that the

prerequisites are met.
5. Run the scripts as required.
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Chapter 3. Installation of the server components

The installation program installs the required software on each computer that you
identify as an IBM Predictive Maintenance and Quality node. The installation
program can be run from one of the computers that will be a node, or it can be
run from another computer.

Installation process
With the IBM Predictive Maintenance and Quality installation program, you can
select the individual computers on which each solution node is to be installed and
enter configuration information for each software component.

In the diagram, the staging server represents the computer from which you run the
installation. In your installation, the staging server can also be used as a node

Figure 2. Predictive Maintenance and Quality installation process
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computer. The staging server must also be using the same operating system as the
other computers on which you install a node. It must also have the same
prerequisites.

Starting the installer for the server components
Use the Launchpad to start the IBM Predictive Maintenance and Quality server
installer.

Before you begin

Ensure that you are logged in as root.

You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser installed and set as your default web browser on the computer from
where you run the installation.

Procedure
1. In a terminal window, go to the USB hard disk drive that you mounted or to

the directory where you copied the installation files.
2. Go to the ServerInstaller/disk1 directory.
3. Type the following command to change the permissions for the installation

files:
chmod -R 755 *

4. Enter the following command:
./launchpad.sh

5. Review the information in the Launchpad panels.
6. To start the Deployment Wizard, click Install Server > Predictive Maintenance

and Quality Server Installer.

Setting port numbers for the Deployment Wizard to use
If you opened ports for the installation of IBM Predictive Maintenance and Quality
components, you must set those port numbers in the Deployment Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you are using the computer on which you are running the installation as a
node, do the following steps:
a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
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Note: The RMI Registry Port is unavailable if you are using localhost as a
node.

Installing or selecting a database instance
IBM Predictive Maintenance and Quality requires a database instance. You can
install IBM DB2 from the Deployment Wizard or use an existing IBM DB2
instance.

If you are using an existing IBM DB2 instance, it must be IBM DB2 Enterprise
Server Edition 9.7 with IBM DB2 9.7 Fix Pack 7.

Procedure
1. Select one of the following options:

v Install IBM DB2 Enterprise Server Edition

v Use existing IBM DB2 Enterprise Server Edition

If you select this option, IBM DB2 Enterprise Server Edition must already be
installed and running on the Data node computer.

2. Click Next.

Specifying the target computers to install the server components
You must specify a different target computer for each IBM Predictive Maintenance
and Quality node. A node can be installed on a computer or virtual machine, but
each node must be installed on a separate computer or virtual machine.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file. You may have to restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you install a node in the Target
Computer box.
The Deployment Wizard prompts you for each node computer.
If you are installing a node on the computer where you are running the
Deployment Wizard, you can enter localhost.

2. Click Add.
a. When you enter a computer other than localhost, in the Target Computer

Credentials box, enter the User ID and Password for the root user.

Important: Ensure that you enter the credentials for the root user on the
target computer.
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b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you opened ports for the installation.
a. Click Edit > Preferences.
b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you are using localhost as a node in the installation, the RMI
Registry Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 9.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/host file has the correct entries.
5. Click Next.
6. Repeat the steps for each computer on which you install a node.

Configuring parameters for the server components installation
The Deployment Wizard displays some default values for each component of IBM
Predictive Maintenance and Quality. You can accept the default values or change
them to suit your environment.

If you are prompted for users, the Deployment Wizard creates the users on the
appropriate target node computer, if they do not exist. For example, IBM DB2
requires a DB2 administrator user, an instance owner user, and a fenced user. Each
of these users is created on the Data node computer.

Procedure

Use the following tables to verify or enter values in each field on each panel of the
Deployment Wizard:
v Clicking Browse browses the target computer's file system. It does not browse

the local computer from where you are running the Deployment Wizard.
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v For some values, such as passwords, default values are not provided. Ensure
that you enter all values on each panel of the Deployment Wizard.

v On the Configure IBM DB2 Enterprise Edition page, enter a name for each
database that is to be created by the Deployment Wizard.

Important: Ensure you use a separate database for each product.

Important: You cannot use the same user for the IBM DB2 administrative user
and the instance owner. They must be different users.

Table 1. IBM DB2 configuration parameters for a new database server installation

Field Default or example value Description

DB2 Server Installation
Directory

/opt/ibm/db2/V9.7 The location where IBM DB2
is to be installed on the Data
node computer.

DB2 Database Port Number 50000 The port number that is used
by IBM DB2.

DB2 Server Administrative
User Name

dasusr1 The user ID that runs the
administration server.

DB2 Server Administrative
Password

There is no default value for
this field.

The password for the user ID
that runs the administration
server.

DB2 Server Administrative
Home Directory

/home/dasusr1 The home directory for the
user ID that runs the
administration server. This
directory is on the Data node
computer's file system.

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

DB2 Instance Owner Home
Directory

/home/db2inst1 The home directory for the
DB2 instance owner user.
This directory is on the Data
node computer's file system.

DB2 Fenced User Name db2fenc1 The user ID that can run
user-defined functions and
store procedures.

DB2 Fenced Password There is no default value for
this field.

The password for the DB2
instance owner user.

DB2 Fenced User Home
Directory

/home/db2fenc1 The home directory for the
DB2 instance owner user.
This directory is on the Data
node computer's file system.

Table 2. IBM DB2 configuration parameters for an existing database server

Field Default or example value Description

DB2 Installation Location /opt/ibm/db2/V9.7 The location where IBM DB2
is installed on the Data node
computer.
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Table 2. IBM DB2 configuration parameters for an existing database server (continued)

Field Default or example value Description

DB2 Instance Name db2inst1 The name of the instance in
which your databases will be
created.

DB2 Instance Password There is no default value for
this field.

The password for the DB2
instance owner user.

DB2 Port Number 50000 The port number that is used
by IBM DB2.

Table 3. IBM DB2 configuration parameters: Database names.
Important: The database names cannot exceed 8 characters.

Field Default or example value Description

SPSS Database Name SPSSDB The SPSS database that is
used by the components that
are installed on the
Predictive Analytics node
computer.

Cognos Database Name COG102CS The IBM Cognos content
store database.

MDM Database Name MDMDB The Master Data
Management (MDM) node
database.

Table 4. IBM DB2 client parameters.
Note: The values entered are applied to all nodes where the IBM DB2 client is installed.

Field Default or example value Description

DB2 Client Installation
Directory

/opt/ibm/db2/V9.7 The location where the IBM
DB2 client is to be installed.
This directory is on the
MDM node, Business
Intelligence (BI) node, and
Analytics node computer's
file system.

DB2 Client Instance User
Name

db2inst1 The user ID for the DB2
client.

DB2 Client Instance
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

DB2 Client Instance Home
Directory

/home/db2inst1 The home directory for the
DB2 client instance owner
user on each node.

Table 5. WebSphere installation parameters

Field Default or example value Description

WebSphere Installation
Directory

/opt/IBM/WebSphere/
AppServer

The location where the
WebSphere Application
Server is to be installed. The
location is the same for each
node where WebSphere is
installed.
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Table 6. HTTP Server installation parameters

Field Default or example value Description

HTTP Server Installation
Directory

/opt/IBM/HTTPServer The location where IBM
HTTP Server is to be
installed. This directory is on
the BI node computer's file
system.

HTTP Port Number 80 The port number that is used
by HTTP Server.

Table 7. IBM Cognos BI installation parameters

Field Default or example value Description

Cognos BI Installation
Location

/opt/ibm/cognos/c10_64 The location where IBM
Cognos BI is to be installed.
This directory is on the BI
node computer's file system.

Table 8. WebSphere profile for IBM Cognos BI parameters.
Note: The settings in this table are applied to the WebSphere installation on the BI node.

Field Default or example value Description

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the BI node computer's file
system.

WebSphere Profile Name COGNOSProfile The name of the WebSphere
profile that is used for IBM
Cognos BI.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the BI node computer.

WebSphere Profile template
location

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

Table 9. IBM Cognos BI Server parameters

Field Default or example value Description

Database Host Name This value is automatically
entered.

The name or IP address of
the Data node computer.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the BI node.

Cognos Dispatcher
Application Server Port

9080 The HTTP transport port
number for the WebSphere
Application Server where
IBM Cognos is running.

Database Server Host Name This value is automatically
entered.

The name or IP address of
the Data node.
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Table 10. WebSphere Message Broker installation parameters

Field Default or example value Description

WebSphere Message Broker
Installation Location

/opt/ibm/mqsi/8.0.0.1 The location where
WebSphere Message Broker
is to be installed. This
directory is on the Enterprise
Service Bus (ESB) node
computer's file system.

WMB ODBC Database
Extender Install Location

/opt/ibm/IE02/2.0.0 The location where
WebSphere Message Broker
ODBC Database Extender is
to be installed. This directory
is on the Enterprise Service
Bus (ESB) node computer's
file system.

WebSphere Message Broker
Explorer Installation
Directory

/opt/IBM/MBExplorer The location where
WebSphere Message Broker
Explorer is to be installed.
This directory is on the
Enterprise Service Bus (ESB)
node computer's file system.

Table 11. WebSphere Message Broker and Queue installation parameters

Field Default or example value Description

ESB Deployment Location /var/PMQ The location where
Predictive Maintenance and
Quality files can be placed.

Location of the IBM Data
Server Driver for ODBC
and CLI

/var/odbc_cli The location where you
downloaded the IDM Data
Server Driver.

This directory is on the ESB
node computer's file system.

Broker Name pmqbroker The broker to be created.

Queue Manager Name pmqmanager The Queue Manager name to
be created.

Execution Group pmqgroup The name of a group of
message flows that are
assigned to a broker

Specify Database Node IP
Address

This value is automatically
entered.

The name of IP address of
the Data node computer.

Table 12. WebSphere Message Broker installation parameters

Field Default or example value Description

MDM Collaboration Server
Installation Directory

/opt/IBM/MDMPIM The location where Master
Data Management
Collaboration Server is to be
installed.

This directory is on the
MDM node computer's file
system.
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Table 13. InfoSphere Master Data Management parameters

Field Default or example value Description

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the MDM node computer's
file system.

WebSphere Profile Name MDMProfile The name of the WebSphere
profile that is used for
InfoSphere Master Data
Management.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the MDM node computer.

Default WebSphere
Template Path

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

MDM DB2 Host Name This value is automatically
entered.

The name or IP address of
the Data node computer.

Perl Installation Directory /opt/ActivePerl-5.16 The location where you
installed Active Perl.

This location on the MDM
node computer.

Table 14. IBM SPSS Collaboration and Deployment Server parameters

Field Default or example value Description

SPSS Collaboration and
Deployment Services
Installation Directory

/opt/IBM/SPSS/Deployment/
5.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is to be
installed. This location is on
the Analytics node
computer's file system.

WebSphere Profile Location /opt/IBM/WebSphere/
AppServer/profiles

The location where the
WebSphere profile is to be
created. This directory is on
the Analytics node
computer's file system.

WebSphere Profile Default
Template Location

/opt/IBM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located. This directory is
on the Analytics node
computer's file system.

WebSphere Profile Name SPSSProfile The name of the WebSphere
profile that is used for the
SPSS products.

WebSphere Host Name This value is automatically
entered.

The name or IP address of
the Analytics node computer.

SPSS DB2 Database Host
Name

This value is automatically
entered.

The name or IP address of
the Data node computer.

Modeler Server Installation
Directory

usr/IBM/SPSS/
ModelerServer/15.0

The directory where the IBM
SPSS Modeler Server is to be
installed. This directory is on
the Analytics node computer.
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Table 14. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field Default or example value Description

SPSS Collaboration and
Deployment Services
Enterprise Viewer
Installation Directory

/opt/IBM/SPSS/Deployment/
5.0/EnterpriseViewDriver

The directory where the IBM
SPSS Collaboration and
Deployment Services
Enterprise View Driver is to
be installed. This directory is
on the Analytics node
computer.

SPSS Collaboration and
Deployment Services
Python Installation
Directory

/opt/IBM/SPSS/Deployment/
5.0/PythonEssentials

The directory where the IBM
SPSS Collaboration and
Deployment Services Python
Scripting Essentials is to be
installed. This directory is on
the Analytics node computer.

SPSS Data Access Pack
Installation Directory

/root/SDAP61 The directory where the IBM
SPSS Data Access Pack is to
be installed. This directory is
on the Analytics node
computer.

SPSS Statistics Installation
Directory

/opt/IBM/SPSS/
StatisticsServer21

The directory where the IBM
SPSS Statistics Server is to be
installed. This directory is on
the Analytics node computer.

Starting the installation
After you enter all of the required fields in the Deployment Wizard, you can start
the installation and configuration of the IBM Predictive Maintenance and Quality
components.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.

Note: If you choose to deploy the tasks individually, you must click Deploy task
for each task in the order that the tasks appear on the Summary panel.

Configure the server components and test the installation
After the installation of the IBM Predictive Maintenance and Quality server
components is complete, you must perform some additional configuration tasks
and then test the installation.

Testing the database installation and configuration
You can test the database installation and configuration by logging in to the Data
node computer and listing the databases on the server. You can also list the
databases available on each node computer where the IBM DB2 client was
installed.

Procedure
1. Log on to the Data node computer.

a. Open a terminal window, and change to the database instance owner user.
For example, su - db2inst1.
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b. Enter the following command to list the databases on the computer:
db2 list database directory

The following databases are listed:
v COG102DB

v MDMDB

v SPSSDB

2. Log on to the Business Intelligence (BI) node computer.
a. Open a terminal window, and change to the database client user. For

example, su - db2inst1.
b. Enter the following command to list the databases on the computer:

db2 list database directory

COG102DB is listed.
3. Log on to the Predictive Analytics node computer.

a. Open a terminal window, and change to the database client user. For
example, su - db2inst1.

b. Enter the following command to list the databases on the computer:
db2 list database directory

SPSSDB is listed.
4. Log on to the Master Data Management (MDM) node computer.

a. Open a terminal window, and change to the database client user. For
example, su - db2inst1.

b. Enter the following command to list the databases on the computer:
db2 list database directory

MDMDB is listed.

Configuring WebSphere Application Server for IBM Cognos BI
To complete the installation of the IBM Predictive Maintenance and Quality server
components, you must configure properties in IBM WebSphere Application Server
for IBM Cognos Business Intelligence.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the WebSphere Admin Console that

was installed on the BI node computer.
The Admin console address is: http://bi_node_name:9060/ibm/console. Where
bi_node_name is the name or IP address for the BI node computer.

3. Expand Servers > Server Types > WebSphere application servers, and click
server1.

4. Under Server Infrastructure, expand Java and Process Management, and
click Process Definition.

5. Under Additional Properties, click Java Virtual Machine.
6. In the Initial Heap Size box, enter 512.
7. In the Maximum Heap Size box, enter 1024.
8. Click Apply, and then click Save.
9. Under Additional Properties, click Environment Variables.

10. Click New.
11. In the Name box, enter LD_LIBRARY_PATH.
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12. In the Value box, enter the path the IBM Cognos BI bin64 directory. For
example, enter /opt/ibm/cognos/c10_64/bin64/.

Important: If you changed the default value in the Cognos BI Installation
Location field in the Deployment Wizard, ensure you use the path you
entered.

13. Click Apply, and then click Save.

Saving your IBM Cognos Configuration settings and starting
the services

You must save the configuration settings in IBM Cognos Configuration before you
can start the IBM Cognos application in WebSphere Application Server.

Procedure
1. Log in to the BI node computer as root.
2. Go to the /opt/ibm/cognos/c10_64/bin64 directory.
3. Type the following command:

./cogconfig.sh

IBM Cognos Configuration starts.
4. Click File > Save.
5. Close IBM Cognos Configuration.

Important: If you are prompted to start the Cognos Content Database service,
click No.

6. Log in to the BI node computer as root using a terminal emulator, such as
PuTTY.

Note: Using a terminal emulator like PuTTY ensures that the proper profile is
loaded.

7. Go to the WebSphere Application Server Profile Location. For example, go to
the /opt/IBM/WebSphere/AppServer/profiles/COGNOSProfile/bin directory if
you used the default path in the Deployment Wizard.

8. Type ./stopServer.sh server1 to stop WebSphere Application Server.
9. Type ./startServer.sh server1 to start WebSphere Application Server.

Results

WebSphere Application Server is configured for IBM Cognos BI.

It may take several minutes for all of the IBM Cognos services to start for the first
time.

Setting the password for the mqm user on the ESB node
computer

You must set the password for the mqm user on the Enterprise Service Bus (ESB)
node computer.

Procedure
1. Log in to the ESB node computer as root.
2. Type the following command:

passwd mqm
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3. Enter mqm and the new password.
You do not have to use mqm. It is only a suggestion. If you do use mqm, you will
see a message saying that your password is too weak. But, you can ignore the
message.

Testing the installation of the server components
You can test the installation of the IBM Predictive Maintenance and Quality server
components by accessing some of the component portals.

For example, you can open the IBM Cognos BI portal on the BI node. If the portal
opens, IBM Cognos BI is installed and running. You can also access the SPSS
configuration tool on the Analytics node computer.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the IBM Cognos Content Manager

status page.
The address is http://bi_node_name:9080/p2pd/servlet, where bi_node_name is
the name or IP address for the BI node computer.
The Content Manager status says Running.

3. In the address bar, type the address for the IBM Cognos BI portal.
The address is http://bi_node_name/ibmcognos/, where bi_node_name is the
name or IP address for the BI node computer.

Note: Ensure that you add the trailing / to the URL.
IBM Cognos Connection appears.

4. In the address bar, type the address for the SPSS administration console.
The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Analytics node
computer.
The SPSS administration console appears.

Computer firewall settings to run the server components
Each IBM Predictive Maintenance and Quality node computer requires certain
ports to be opened for the server components to operate in a multi-computer
solution, and you must configure your firewall settings for each specific node.

Configuring your firewall settings for all nodes
On each computer on which you install an IBM Predictive Maintenance and
Quality node, you must open specific ports.

The following ports must be open:
v vnc-server

v x11

v 5901

v 5902

v 5903

v 6001

v 6002
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v 6003

v 22

Procedure
1. Log in as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open vnc-server, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport vnc-server -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added port should appear in the list.
7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node.

Configuring your firewall settings for the Analytics node
computer

You must ensure that certain ports are open on the Predictive Analytics node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v 45088

v 58313

v 28052

v tungsten-https

v glrpc

v corbaloc

v 59356

v 9043

v 9060

Procedure
1. Log in to the Analytics node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 45088, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 45088 -j ACCEPT

4. Repeat the previous step for each of the required port values.
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5. Type the following command to save your firewall settings:
/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the BI node computer
You must ensure that certain ports are open on the Business Intelligence (BI) node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v 9362

v vrace

v 9663

v corbaloc

v 9043

v glrpc

v http

v tungsten-https

v 9060

v 6001

v 6002

v 6003

v 5901

v 5902

v 5903

Procedure
1. Log in to the BI node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 9362, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9362 -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.
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Configuring your firewall settings for the ESB node computer
You must ensure that certain ports are open on the Enterprise Service Bus (ESB)
node computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v boks

v boks_clntd

v boks_servm

v boks_servc

v ibm-mqseries

Procedure
1. Log in to the ESB node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open boks, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the MDM node computer
You must ensure that certain ports are open on the Master Data Management
(MDM) node computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
v 9060

v tungsten-https

v 50498

v 9634

v 9633

v 57537

v 49888

v 53343

v 41950

v 60573

v 43420

v 40187

v netsteward
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v corbaloc

v glrpc

v 44152

v 43830

v 39188

v 9043

v 7507

v 49298

v 8881

v cddbp-alt

v 40752

v 50512

v 35086

v bacula-dir

v jetdirect

v 55052

v 32970

v commplex-link

v 37253

v 9060

Procedure
1. Log in to the MDM node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 9060, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9060 -j ACCEPT

4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:

/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the Data node computer
You must ensure that certain ports are open on the Data node computer for IBM
Predictive Maintenance and Quality.

The following ports must be open:
v ibm-db2

v db2c_db2inst1

Chapter 3. Installation of the server components 29



Procedure
1. Log in to the Data node computer as root.
2. Back up your existing firewall settings by typing the following command:

/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open ibm-db2, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport ibm-db2 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.
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Chapter 4. Installation of the server artifacts

The server artifacts include report content and workflows for IBM Predictive
Maintenance and Quality. The installation program will install artifacts on each
node computer.

Starting the installer for the server artifacts
Use the Launchpad to start the IBM Predictive Maintenance and Quality server
artifacts installer.

Before you begin

Ensure that you are logged in as root.

You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser installed and set as your default web browser on the computer from
where you run the installation.

Procedure
1. In a terminal window, go to the USB hard disk drive that you mounted or to

the directory where you copied the installation files.
2. Go to the ServerArtifacts/disk1 directory.
3. Type the following command to change the permissions for the installation

files:
chmod -R 755 *

4. Enter the following command:
./launchpad.sh

5. Review the information in the Launchpad panels.
6. Click Install Server Artifacts > Predictive Maintenance and Quality Server

Artifacts Accelerator to start the Deployment Wizard to install the server
artifacts.

7. Follow the prompts to install the server artifacts.
8. On the Select Tasks page, select all nodes.

Setting port numbers for the Deployment Wizard to use
If you opened ports for the installation of IBM Predictive Maintenance and Quality
components, you must set those port numbers in the Deployment Wizard.

Procedure
1. In the Deployment Wizard, click Edit > Preferences.

The Deployment Preferences window appears.
2. Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.
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Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you are using the computer on which you are running the installation as a
node, do the following steps:
a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.
c. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you are using localhost as a
node.

Specifying the target computers on which you will install the server
artifacts

You must specify a each computer on which you installed an IBM Predictive
Maintenance and Quality node. Ensure that you identify the correct computer for
each node.

Before you begin

You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:
1. On the target computer, go to the /etc/ssh directory and open sshd_config for

editing.
2. Change the PermitRootLogin property to yes.
3. Save the file. You may have to restart the server for the change to take effect.

Procedure
1. On the Specify Target Computers pages of the Deployment Wizard, enter the

name or IP address of the computer on which you installed the node you are
prompted for in the Target Computer box.
The Deployment Wizard prompts you for each node computer.
If you installed a node on the computer where you are running the
Deployment Wizard, enter localhost.

2. Click Add.
a. When you enter a computer other than localhost, in the Target Computer

Credentials box, enter the User ID and Password for the root user.

Important: Ensure that you enter the credentials for the root user on the
target computer.

b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you opened ports for the installation.
a. Click Edit > Preferences.
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b. Click Target Computer Settings.
c. Select the computer name or IP address in the Target Computer field.
d. Enter the communication port number that you set in the Communication

Port field. For example, enter 35000.
e. Enter the Data Port Number that you set in the RMI Registry Port field.

For example, enter 30000.

Note: If you are using localhost as a node in the installation, the RMI
Registry Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.
If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.
v Edit your iptable settings or temporarily disable your firewall. For more

information, see “Computer firewall settings required for the installation” on
page 9.

v Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

v Ensure that the /etc/host file has the correct entries.
5. Click Next.
6. Repeat the steps for each node computer.

Configuring parameters for the server artifacts installation
The Deployment Wizard displays some default values for each component. You
can accept the default values or change them to suit your environment.

Procedure

Use the following table to verify or enter values in each field on each panel of the
Deployment Wizard.

Table 15. Data node parameters

Field Default or example value Description

Data Node Deployment
Location

/opt/IBM/PMQ/Data The location where the
server artifacts are to be
installed on the Data node
computer.

DB2 Instance Owner User
Name

db2inst1 The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.
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Table 15. Data node parameters (continued)

Field Default or example value Description

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.
Note: Ensure that you use
the same password as you
provided during the server
installation.

Table 16. Enterprise Service Bus (ESB) node parameters

Field Default or example value Description

Enterprise Service Bus Node
Deployment Location

/var/PMQ The location where the
server artifacts are to be
installed on the ESB node
computer.

Installation Location of
Message Broker

/opt/ibm/mqsi/8.0.0.1 The location where
WebSphere Message Broker
is installed. This directory is
on the ESB node computer's
file system.

Websphere Message Queue
Location

/opt/mqm The location where
WebSphere Message Queue
is installed. This directory is
on the ESB node computer's
file system.

Broker Name pmqbroker The broker name that you
created.

Queue Manager Name pmqmanager The Queue Manager name
that you created.

Execution Group pmqgroup The name of a group of
message flows that are
assigned to a broker that you
created.

PMQIntegration SPSS
WebService URL

http://
analytics_node_name:port/
scoring/services/
Scoring.HttpV1

Where analytics_node_name
is the name or IP address of
the Predictive Analytics node
computer, and port is the
HTTP port for the
WebSphere instance, for
example 9080.

PMQMaximoIntegration
SPSS WebService URL

http://
analytics_node_name:
port/meaweb/services/
EXTSYS1_MXWOInterface

Where analytics_node_name
is the name or IP address of
the Analytics node computer,
and port is the HTTP port
for the WebSphere instance,
for example 9080.

Table 17. Business Intelligence (BI) node parameters

Field Default or example value Description

Business Intelligence
Deployment Location

/opt/IBM/PMQ/BI The location where the
server artifacts are to be
installed on the BI node
computer.
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Table 17. Business Intelligence (BI) node parameters (continued)

Field Default or example value Description

Cognos Install Location /opt/ibm/cognos/c10_64 The location where IBM
Cognos BI is installed. This
directory is on the BI node
computer's file system.

WebSphere Install Location /opt/IBM/WebSphere/
AppServer

The location where
WebSphere is installed. This
directory is on the BI node
computer's file system.

DB2 Instance Home
Directory

/home/db2inst1 The home directory of the
database instance owner.

Cognos BI Dispatcher URI http://bi_node_name:9080/
p2pd/servlet/dispatch

The URL to the IBM Cognos
BI dispatcher, where
bi_node_name is the name or
IP address of the BI node
computer.

DB2 Database Instance User
Name

db2inst1 The user ID for the IBM
Cognos content store
database.

DB2 Database Instance
Password

There is no default value for
this field.

The password for the
database instance owner
user.

DB2 Database Port Number 50000 The port number for the IBM
DB2 database server.

DB2 Database Hostname There is no default value for
this field.

The name or IP address of
the Data node computer.

Table 18. Analytics node parameters

Field Default or example value Description

Analytics Deployment
Location

/opt/IBM/PMQ/Analytics The location where the
server artifacts are to be
installed on the Analytics
node computer.

Modeler Server Install
Location

/usr/IBM/SPSS/
ModelerServer/15.0

The location where the
Modeler Server is installed.

Collaboration and
Deployment Services Install
Location

/opt/IBM/SPSS/Deployment/
5.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is
installed. This location is on
the Analytics node computer.

Table 19. Master Data Management (MDM) node parameters

Field Default or example value Description

Master Data Deployment
Location

/opt/IBM/PMQ/MDM The location where the
server artifacts are to be
installed on the MDM node
computer.
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Starting the installation of the server artifacts
After you enter all of the required fields in the Deployment Wizard, you can start
the installation of the server artifacts.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.

Note: If you choose to deploy the tasks individually, you must click Deploy task
for each task in the order that the tasks appear on the Summary panel.

Complete the configuration of the server components
After you have installed the IBM Predictive Maintenance and Quality server
artifacts, you can complete the configuration of the server components.

Verifying the configuration of IBM SPSS Collaboration and
Deployment Services

To complete the configuration of IBM SPSS Collaboration and Deployment Services
Server, you must verify the URL Prefix value for your environment.

Procedure
1. Open a web browser.
2. In the address bar, type the address for the Collaboration and Deployment

administration console.
The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Predictive Analytics
node computer.

3. Enter the Login name and Password for the administrator user, and click
Login.
The default Login name is admin, and the default Password is admin.

4. On the Configuration panel, under Setup, click URL Prefix.
5. In the URL Prefix box, verify that the address is http://

analytics_node_name:9080, where analytics_node_name is the name or IP
address of the Analytics node computer.

6. If the value is correct, you do not have to complete the remaining steps in this
task.

7. If the value is not correct, enter the name or IP address of the Analytics node
computer, and click Set.

8. Open the WebSphere Administrative Console in your web browser.
The address is http://analytics_node_name:9060/ibm/console, where
analytics_node_name is the name or IP address for the Analytics node
computer. 9060 is the default port number for the WebSphere Administrative
Console.

9. Click Log in.
You do not need to enter a value in the User ID box.

10. Under Applications > Application Types > WebSphere Enterprise
Applications, select
IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click Stop.
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11. Select IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click
Start to restart the application and apply the changes.

Configuring the MDM node
To configure the Master Data Management (MDM) node, you must log in to the
MDM administration console and import content files.

The content files are installed onto the MDM node computer by the Server Artifact
installer. You must copy the content files from the MDM node to a computer where
you have Microsoft Internet Explorer installed.

Procedure
1. Copy the MDM node contents to your Microsoft Windows-based computer

with an FTP client or by using a shared directory.
The contents files are installed to /opt/ibm/PMQ by default on the MDM node
computer. The contents file is named IBMPMQ.zip.

2. In Microsoft Internet Explorer, go to the MDM administration console.
The address is http://mdm_node_name:7507/utils/enterLogin.jsp, where
mdm_node_name is the name or IP address of the MDM node computer.

3. In User name, enter Admin.

Note: These values are case-sensitive.
4. In the Password box, enter trinitron.
5. In the Company box, enter IBMPMQ.
6. Click Login.
7. Click System Administrator > Import Environment.
8. In the Import Company Environment box, browse to and select the

IBMPMQ.zip file that you copied.
9. Click Import.

10. Log out, and log back in to the MDM administration console to ensure that
the import was completed.
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Chapter 5. Installation of the client components

There are several client components that are included with IBM Predictive
Maintenance and Quality. You can install the components as you require.

Important: The client components must be installed on computers running the
Microsoft Windows 7 64-bit operating system.

Important: Install the client components only after you successfully install the
server components.

Client components
The following client components for IBM Predictive Maintenance and Quality are
available to be installed.

Database connectivity

IBM DB2 Connect™ must be installed to enable connectivity to the analytics
database.

Predictive modeling and decision management

Install the following components so that you can modify or create predictive
models and so that you can perform decision management tasks:
v IBM SPSS Collaboration and Deployment Services Deployment Manager
v IBM SPSS Modeler Client
v IBM SPSS Statistics Client
v IBM SPSS Text Analytics Client

Optionally, install the following components:
v IBM SPSS Collaboration and Deployment Services Documentation
v IBM SPSS Decision Management Documentation
v IBM SPSS Modeler Client Documentation
v IBM SPSS Statistics Desktop

Business intelligence

Install IBM Cognos Framework Manager so that you can modify the reporting
model metadata.

Optionally, install the following components:
v IBM Cognos Business Intelligence Samples
v IBM Cognos Dynamic Query Analyzer
v IBM Cognos for Microsoft Office
v IBM Cognos Lifecycle Manager
v IBM Cognos Mobile
v IBM Cognos Real-time Monitoring
v IBM Cognos Software Development Kit

© Copyright IBM Corp. 2013 39



v IBM Cognos Supplementary Languages Documentation

Enterprise service bus

Install the following components:
v WebSphere Message Broker Toolkit
v WebSphere MQ for Windows

Use the WebSphere Message Broker Toolkit to create, manage, deploy, and delete
message flows and associated resources in a development environment.

Starting the installer for the client components
The IBM Predictive Maintenance and Quality client installers are provided on the
same USB hard disk drive as the server and content installers.

Important: The Deployment Wizard copies the installers to your computer. You
must run each installer individually after they are copied to your computer.

Procedure
1. Insert the Predictive Maintenance and Quality USB hard disk drive into the

USB port of your Microsoft Windows 7-based computer.
2. Go to the Client/disk1 directory.
3. Double-click launchpad64.exe.
4. Review the information in the Launchpad panels.
5. Click Install Client > Predictive Maintenance and Quality Client Accelerator

to start the Deployment Wizard.
6. On the Select Tasks panel, select the groups of clients you want to install, and

click Next to select the client components that you want to install.

Important: The required client components include the following:
v WebSphere Message Broker Toolkit
v WebSphere MQ for Windows
v IBM SPSS Collaboration and Deployment Services Deployment Manager
v IBM SPSS Modeler Client
v IBM SPSS Statistics Desktop
v IBM SPSS Statistics Client
v IBM SPSS Text Analytics Client
v IBM Cognos Framework Manager

7. Enter a location for each client component installer to be copied to. The default
is C:\IBM\PMQ\Client Installer.

8. On the Summary Panel, click Deploy all.
9. After the client installers are copied to your computer, you must install each

client individually by using its installer.

Installing IBM SPSS Collaboration and Deployment Services
Deployment Manager

You must install IBM SPSS Collaboration and Deployment Services Deployment
Manager to complete the configuration of IBM Predictive Maintenance and Quality.
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Install IBM SPSS Collaboration and Deployment Services Deployment Manager on
a computer running the Microsoft Windows 7 operating system.

Procedure
1. Go to the install_location\Client Installer\Analytics\IBM SPSS

Collaboration and Deployment Services Deployment Manager directory.
By default, the install_location is C:\IBM\PMQ\.

2. Extract the installer files from the zip file.
3. Double-click install.exe to start the IBM SPSS Collaboration and Deployment

Services Deployment Manager installation.
4. Follow the steps in the wizard to install the client component.

For more information about the installation of Deployment Manager, see the
IBM SPSS documentation (pic.dhe.ibm.com/infocenter/spsscads/v5r0m0/
index.jsp).

Adding a content server connection for IBM SPSS
Collaboration and Deployment Services

You must add a connection to your IBM SPSS Collaboration and Deployment
Services repository in the IBM SPSS Collaboration and Deployment Services
Deployment Manager client.

After you add the connection, the server folder displays in the Content Explorer,
and you can log in to the server.

Procedure
1. On your Microsoft Windows computer, start IBM SPSS Collaboration and

Deployment Services Deployment Manager. For example, click Start >
Deployment Manager.

2. Click File > New > Content Server Connection.
3. In the Connection Name box, enter a name for your Collaboration and

Deployment Services repository.
4. In the Host box, enter the name or IP address of the Predictive Analytics node

computer.
5. In the Port box, enter 9080.

9080 is the port number used by the WebSphere Application Server instance.
6. Click Finish.
7. Click the connection name that you created.
8. In the User ID box, enter admin.
9. In the Password box, enter admin.

10. Click OK.

Adding users and groups to IBM SPSS Collaboration and
Deployment Services

You use IBM SPSS Collaboration and Deployment Services Deployment Manager
to manage users and groups. You must add an administrator user for IBM
Predictive Maintenance and Quality.

Procedure
1. In Deployment Manager, click Tools > Server Administration.
2. Click Click here to define a new administrative server connection.
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3. In the Name box, enter a name for your server, and click Next.
4. In the Host box, enter the name or IP address of Predictive Analytics node

computer.
5. In the Port box, enter the port number of for the WebSphere instance. The

default value is 9080.
6. Click Finish.
7. Double-click the connection name that you created.
8. In the User ID box, enter admin.
9. In the Password box, enter admin.

10. Click OK.
11. Expand Users and Groups, and double-click Local User Repository.
12. Select Show all available users/groups.
13. Click New Group.

a. Enter administrator.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

14. Click New Group.
a. Enter DM Administrator.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

15. Click New Group.
a. Enter DM Users.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.

16. Double-click Roles.
17. Click New Role.

a. In the Role Name box, enter DM Administrator.
b. Click Select All to add all actions for this user role.
c. Click OK.
d. Select the DM Administrator role, and click Edit Users and Groups.
e. Click Show all available users/groups.
f. Under Available users, move the DM Administrator group to

Users/Groups Assigned to Role.
g. Click OK.

18. Click New Role.
a. In the Role Name box, enter DM User.
b. Click Select All to add all actions for this user role.
c. Click OK.
d. Select the DM User role, and click Edit Users and Groups.
e. Click Show all available users/groups.
f. Under Available users, move the DM Users group to Users/Groups

Assigned to Role.
g. Click OK.
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Importing the Predictive Maintenance and Quality resource
definitions into IBM SPSS Collaboration and Deployment
Services

Resource definitions include credential definitions, data source definitions, message
domains, promotion policies, server definitions, and server cluster specifications.
These resources are required for running jobs.

You must import these resource definitions into IBM SPSS Collaboration and
Deployment Services Deployment Manager.

The resource files are installed onto the Predictive Analytics node computer by the
Server Artifact installer. You must copy the content files from the Analytics node to
the computer where you installed Deployment Manager.

Procedure
1. Copy the Analytics node contents to your Windows-based computer using

either an FTP client or by using a shared directory.
The contents files are installed to /opt/ibm/PMQ by default on the Analytics
node computer.

2. On your Windows-based computer, in Deployment Manager, click Content
Explorer.

3. Right-click Content Repository, and click Import.
4. Browse to and select the file named PredictiveMaintenance.pes in the

directory where you copied the Analytics node contents.
5. Click Open.
6. Accept the default options in the Import window, and click OK.

Adding credential definitions to IBM SPSS Collaboration and
Deployment Services

You must add user credential definitions in IBM SPSS Collaboration and
Deployment Services Deployment Manager. You must add the credentials for your
IBM SPSS admin user, the database instance owner, and the root user on the
Predictive Analytics node computer.

Procedure
1. In Deployment Manager, click Content Explorer.
2. Expand Resource Definitions > Credentials.
3. Right-click Credentials, and click New > Credentials Definition.

a. In the Name box, enter admin, and click Next.
b. In the User ID box, enter admin.
c. In the Password box, enter admin.
d. In the Security Provider box, select Local User Repository.
e. Click Finish.

4. Right-click Credentials, and click New > Credentials Definition.
a. In the Name box, enter db2inst1, and click Next.
b. In the User ID box, enter db2inst1.
c. In the Password box, enter the password for your db2inst1 user.
d. Leave the Security Provider box blank.
e. Click Finish.
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5. Right-click Credentials, and click New > Credentials Definition.
a. In the Name box, enter modeler, and click Next.
b. In the User ID box, enter root.
c. In the Password box, enter the password for the root user on the Analytics

node computer.
d. Leave the Security Provider box blank.
e. Click Finish.

Adding server definitions to IBM SPSS Collaboration and
Deployment Services

You must add server definitions in Deployment Manager.

If you are not using a computer that is running the Microsoft Windows 7 operating
system, some entries, such as server types, may not display correctly.

Procedure
1. In Deployment Manager, click Content Explorer.
2. Expand Resource Definitions.
3. Right-click Server, and click New > Server Definition.

a. In the Name box, enter localhost, and click Next.
b. In the Type box, select Content Repository Server.
c. Click Next.
d. In the Host box, enter the name or IP address of Analytics node computer.
e. In the Port box, enter 9080.
f. Click Finish.

4. Right-click Server, and click New > Server Definition.
a. In the Name box, enter modeler, and click Next.
b. In the Type box, select Modeler Server.
c. Click Next.
d. In the Host box, enter the name or IP address of Analytics node computer.
e. In the Port box, leave the default value 28052.
f. In the Default data path box, enter the path to the data directory on

Analytics node computer. For example, enter /usr/IBM/SPSS/ModelerServer/
15.0

g. Click Finish.

Creating scoring configurations
You must create scoring configurations for IBM Predictive Maintenance and
Quality. You create these configurations in IBM SPSS Collaboration and
Deployment Services Deployment Manager.

You must select the appropriate Output data returned settings for the steam you
are configuring:

Table 20. Output data returned settings for each IBM Predictive Maintenance and Quality
stream

Stream name Scoring service name Output data returned setting

Health_Score_Model.str RESOURCE_HEALTH_SCORE HEALTH_SCORE
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Table 20. Output data returned settings for each IBM Predictive Maintenance and Quality
stream (continued)

Stream name Scoring service name Output data returned setting

Life Time
Analysis_Model1.str

RESOURCE_LIFETIME_SCORE RESOURCE_ID

EXPECTED_DEVICE_LIFETIME

Asset_Recommendation.str RESOURCE_RECOMMENDATION HEALTH_RECOMMENDATION

Procedure
1. In Deployment Manager, click Content Explorer.
2. Under Content Repository > PredictiveMaintenance, right-click the model for

which you want to create the scoring. For example, right-click
Health_Score_Model.str.

3. Click Configure Scoring.
4. In the Configure Scoring Model dialog box, click Next.
5. On the Data provider settings panel, click Next.
6. On the Input data order panel, click Next.
7. On the Input data returned settings panel, click Next.
8. On the Output data returned settings panel, select the appropriate score, and

click Next. For example, for Health_Score_Model.str, select HEALTH_SCORE.
9. On the Logging settings panel, click Next.

10. On the Advanced settings panel, click Finish.
11. Repeat these steps for each stream you want to configure.
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Chapter 6. Uninstallation of the IBM Predictive Maintenance
and Quality components

Follow the uninstall instructions for each of the Predictive Maintenance and
Quality components to uninstall the product.

Uninstalling components from the Predictive Analytics node computer
Follow the uninstall instructions for each component on the Analytics node
computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(pic.dhe.ibm.com/infocenter/db2luw/v9r7).
2. To uninstall IBM SPSS Collaboration and Deployment Services, see the IBM

SPSS documentation (pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the WebSphere documentation
(pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

4. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the BI node computer
Follow the uninstall instructions for each component on the Business Intelligence
(BI) node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(pic.dhe.ibm.com/infocenter/db2luw/v9r7).
2. To uninstall IBM Cognos Business Intelligence, see the IBM Cognos BI

documentation (pic.dhe.ibm.com/infocenter/cbi/v10r2m0).
a. Go to the /opt/ibm/cognos/c10_64/uninstall directory.
b. Type ./uninst -u, and press Enter.
c. Follow the steps to uninstall the product.

3. To uninstall IBM HTTP Server, see the IBM HTTP Server for WebSphere
Application Server documentation (pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
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a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

4. To uninstall WebSphere Application Server, see the WebSphere documentation
(pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.

5. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the ESB node computer
Follow the uninstall instructions for each component on the Enterprise Service Bus
(ESB) node computer.

Procedure
1. To uninstall WebSphere Message Broker, see the WebSphere Message Broker

documentation (publib.boulder.ibm.com/infocenter/wmbhelp/v8r0m0).
2. To uninstall WebSphere Message Queue, see the WebSphere Message Queue

documentation (publib.boulder.ibm.com/infocenter/wmqv6/v6r0).

Uninstalling components from the MDM node computer
Follow the uninstall instructions for each component on the Master Data
Management (MDM) node computer.

Procedure
1. To uninstall the IBM DB2 client, see the IBM DB2 documentation

(pic.dhe.ibm.com/infocenter/db2luw/v9r7).
2. To uninstall InfoSphere Master Data Management Server, see the IBM MDM

documentation (pic.dhe.ibm.com/infocenter/mdm/v10r0m0).
a. Go to the /opt/IBM/MDMPIM/_uninst directory.
b. Type ./uninstall.bin, and press Enter.
c. Follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the WebSphere documentation
(pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh server1.
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4. To uninstall IBM Installation Manager, see the IBM Installation Manager
information center (pic.dhe.ibm.com/infocenter/install/v1r6).
a. Go to the /var/ibm/InstallationManager/uninstall directory, and run

uninstall.
b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the Data node computer
Follow the uninstall instructions for each component on the Data node computer.

Procedure

To uninstall IBM DB2, see the IBM DB2 documentation (pic.dhe.ibm.com/
infocenter/db2luw/v9r7).
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Appendix A. Samples

Sample data is provided so that you can see the IBM Predictive Maintenance and
Quality solution work end-to-end.

Loading the sample data
Sample data is installed as part of the IBM Predictive Maintenance and Quality
server artifact installation. You can load the sample data to see an example of the
Predictive Maintenance and Quality solution from end-to-end.

Procedure
1. Log in to the Enterprise Service Bus (ESB) node computer as the mqm user.
2. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/MasterData-Set1

directory.
3. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.
WebSphere Message Broker automatically loads the files from that directory.
The files are automatically removed after they are loaded.

Important: The files must be coped one at a time.
4. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/MasterData-Set2

directory.
5. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/

masterdatain directory one file at a time.

Important: batch_batch_upsert_sample_pmq.csv must be loaded last.
6. Go to the /var/PMQ/MQSIFileInput/PMQSampleData/Sample_PMQ/EventData-Set3

directory.
7. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/eventdatain

directory one file at a time.

Removing sample data
Before you load live production data in IBM Predictive Maintenance and Quality,
all sample data must be removed.

This procedure deletes all the contents of the event and master data tables. Its
scope is not limited to the supplied sample data and so any additional content that
is loaded is also deleted.

Before you begin

If test events were loaded from the sample master data, the test events must also
be removed. For more information, see the IBM Predictive Maintenance and Quality
Solution Guide.

Procedure
1. Type the following command to connect to the IBMPMQ datastore:

db2 "connect to IBMPMQ user user_name using password"
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2. Run SampleDeletes.sql in the location: /opt/IBM/PMQ/Data by using the
following command:
db2 "-tvf /opt/IBM/PMQ/Data/SampleDeletes.sql"

3. Type the following command to commit the transaction:
db2 "commit"

4. Type the following command to populate the master tables with NA rows:
db2 "call SCHEMA.POP_NA( ’EN’ , ’English’ , ’PMQ’ , ’PMQ’ )"

Ensure that the correct schema name is used, such as db2inst1

5. Type the following command to run the Calendar generation procedure:
db2 "call SCHEMA.Calendar_pop"

6. Type the following command to disconnect from the database:
db2 "connect reset"
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Appendix B. Products installed with IBM Predictive
Maintenance and Quality

The following products are installed with or available to be installed with
Predictive Maintenance and Quality.

Server components
v IBM DB2 Enterprise Server Edition 9.7 for Linux on AMD64 and Intel EM64T

systems (x64) English
v IBM DB2 9.7 Fix Pack 7 for Linux/x86-64 (64 bit), DB2 Server Fix Pack
v IBM DB2 Enterprise Server Edition 9.7 Client for Linux on AMD64 and Intel

EM64T systems (x64) English
v IBM WebSphere Network Deployment 8.0 for Multiplatform, Multilingual
v IBM WebSphere Network Deployment 8.0 Fix Pack 5
v IBM WebSphere Network Deployment 8.0 Supplements Pack for Multiplatform

Multilingual
v IBM Installation Manager 1.6 for Linux 64-bit Multilingual
v IBM Cognos Business Intelligence Server 10.2.0 Linux x86 Multilingual
v IBM WebSphere Message Broker V8.0.0.1 Linux x86-64 Multilingual
v IBM WebSphere Message Broker 8.0 Fix Pack 2
v IBM WebSphere Message Broker Explorer 8.0.0.2
v IBM WebSphere Message Broker ODBC Database Extender (IE02)
v IBM WebSphere Message Queue V7.5 for Linux on x86 64bit Multilingual
v IBM SPSS Collaboration and Deployment Services Server 5.0 Red Hat Enterprise

Linux Multilingual
v IBM SPSS Collaboration and Deployment Services Deployment Manager 5.0 Fix

pack 1
v IBM SPSS Collaboration and Deployment Services Enterprise View Driver 64-bit

5.0 Red Hat Enterprise Linux Multilingual
v IBM SPSS Collaboration and Deployment Services Web Installer for Deployment

Manager 5.0 Multiplatform Multilingual
v IBM SPSS Collaboration and Deployment Services Enterprise Python Scripting

5.0 Red Hat Enterprise Linux Multilingual
v IBM SPSS Modeler Server 64-bit 15.0 Linux Multilingual
v IBM SPSS Modeler Server 64-bit 15.0 Fix Pack 1
v IBM SPSS Data Access Pack 6.1 sp3 Multiplatform English
v IBM SPSS Text Analytics Server 64-bit 15.0 Linux Multilingual
v IBM SPSS Modeler 15.0 Collaboration and Deployment Services Adapter 64-bit 5

Linux Multilingual
v IBM SPSS Modeler Collaboration and Deployment Services Adapter 15 Fix Pack

1
v IBM SPSS Decision Management 7.0 Linux Multilingual
v IBM SPSS Decision Management 7.0 Fix Pack 1
v IBM SPSS Decision Management Modeler Extension Libraries 7.0 Linux

Multilingual
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v IBM SPSS Decision Management Modeler Extension Libraries 7.0 Fix Pack 1
v IBM SPSS Decision Management Modeler Advantage 7.0 Linux Multilingual
v IBM SPSS Decision Management Modeler Advantage 7.0 Fix Pack 1
v IBM SPSS Decision Management Customer Applications 7.0 Linux Multilingual
v IBM SPSS Decision Management Customer Applications 7.0 Fix Pack 1
v IBM SPSS Decision Management for Claims 7.0 Linux Multilingual
v IBM SPSS Decision Management for Claims 7.0 Fix Pack 1
v IBM SPSS Statistics 21.0 Collaboration and Deployment Services Adapter 64-bit

5.0 Linux Multilingual
v IBM SPSS Statistics 21.0 Collaboration and Deployment Services Adapter 5.0 Fix

Pack 1
v IBM SPSS Statistics - Essentials for Python 21.0 for Linux 64 Multilingual
v IBM SPSS Statistics Server 64-bit 21.0 Linux Multilingual
v IBM Infosphere Master Data Management Collaboration Server V10.1.0

Multiplatform Multilingual 10.1.0.0
v Quick Start Documentation - IBM Infosphere Master Data Management V10.1.0

Multiplatform Multilingual

Client and optional components
v IBM DB2 Connect Personal Edition 9.7 for Windows® on AMD64 and Intel®

EM64T systems (x64) English
v IBM Cognos Framework Manager 10.2.0 Microsoft Windows Multilingual
v IBM Cognos Business Intelligence Samples 10.2.0 Multiplatform Multilingual
v IBM Cognos Supplementary Languages Documentation 10.2.0 Multiplatform

Multilingual
v IBM Cognos Dynamic Query Analyzer 10.2.0 Multiplatform Multilingual
v IBM Cognos for Microsoft Office 10.1.1 for Business Intelligence 10.2.0 Microsoft

Windows Multilingual
v IBM Cognos Lifecycle Manager 10.2.0 Microsoft Windows English
v IBM Cognos Mobile 10.2.0 Multiplatform Multilingual
v IBM Cognos Real-time Monitoring 10.2.0 Multiplatform Multilingual
v IBM Cognos Software Development Kit 10.2.0 Multiplatform English
v IBM SPSS Collaboration and Deployment Services Deployment Manager 64-bit

5.0 Microsoft Windows Multilingual
v IBM SPSS Collaboration and Deployment Services Documentation 5.0

Multilingual
v IBM SPSS Modeler Client 64-bit 15.0 Microsoft Windows Multilingual
v IBM SPSS Text Analytics Client 64-bit 15.0 Microsoft Windows Multilingual
v IBM SPSS Modeler Client Documentation 15.0 Multilingual
v IBM SPSS Decision Management Documentation 7.0
v IBM SPSS Statistics Client 64-bit 21.0 Microsoft Windows Multilingual
v IBM SPSS Statistics Client/Developer Installation Documentation 21.0

Multilingual
v IBM Message Broker Toolkit V8.0.0.1 Windows 1 Multilingual
v IBM Message Broker Toolkit Fix Pack 2
v IBM Installation Manager V1.6.0 for Windows Multilingual
v IBM WebSphere MQ V7.5 for Windows Multilingual
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Appendix C. Troubleshooting

This section contains troubleshooting information for the IBM Predictive
Maintenance and Quality installation.

Log in as root rather than su or sudo
To run the IBM Predictive Maintenance and Quality installation, you must log in to
the computer from where you run the installation as root. Using su root or sudo
to run the installer is not supported in this version.

Browser not supported for the Launchpad
You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser that is installed and set as your default web browser on the computer
from where you run the IBM Predictive Maintenance and Quality installation. If
you have another browser that is set as your default and want to keep your
existing default browser, you can temporarily use a supported browser for the
installation.

Procedure
1. On the computer from where you run the installation, download a supported

web browser. For example, download Firefox version 10.
2. Uncompress the downloaded file if necessary.
3. In a terminal window, type the following command:

export BROWSER=/path_to_supported_browser

4. Then, start the Launchpad by typing the following command:
./launchpad.sh

The Launchpad should appear in the supported browser.

Installer does not launch
If the IBM Predictive Maintenance and Quality installer does not launch, ensure
that you have completed all of the prerequisite tasks and installed all of the
required rpm packages.

Test Connections validation errors
If you click the Test Connections button in the IBM Predictive Maintenance and
Quality installer and you receive an error, use the following tips to verify
communication between the Deployment Wizard and the target computer.
v Ensure that you entered a valid host name or IP address.
v Ensure that you can ping the target computer from the computer where you are

running the installation.
v Ensure that all of your computers have valid entries in the /etc/hosts file.
v Ensure that your firewall is disabled or that the ports required for the

Deployment Wizard are open on all computers.
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Viewing log files
Log files for the IBM Predictive Maintenance and Quality installation can be
displayed in the Deployment Wizard.

Procedure
1. To view log files in the Deployment Wizard, select the message, and click

Detailed messages or Master log.
2. If you clicked Detailed messages, select a message, and click View Details.

Temporary file locations
Temporary files are created during the IBM Predictive Maintenance and Quality
installation. You can find the location for the temporary files from the Deployment
Wizard.

Procedure

In the Deployment Wizard, click Edit > Preferences.
The path to the location for the temporary files is shown in the Path box.

Ensuring connectivity between the Analytics node and the Data node
computers

In IBM Predictive Maintenance and Quality, if the task for configuring the IBM
SPSS Collaboration and Deployment Services displays a database initialization
error, you may have to run the traceroute command to ensure communication
between the Predictive Analytics node and the Data node.

Procedure
1. On the Analytics node computer, enter the following command:

traceroute data_node_name

Where data_node_name is the name or IP address of the Data node computer.
2. Try the task again.

Modeler Server type not displaying in resource definitions
In IBM Predictive Maintenance and Quality, if the Modeler Server type does not
display in resource definitions in IBM SPSS Collaboration and Deployment Services
Deployment Manager, try closing Deployment Manager and opening it again.

Unable to import the company archive in MDM
If you cannot import the IBM Predictive Maintenance and Quality company
archive in the Master Data Management (MDM) console, you can manually import
the archive.

Procedure
1. Log in to the MDM node computer as root.
2. Copy the IBMPMQ.zip file from /opt/IBM/PMQ/MDM_version directory to the

/opt/IBM/PMQ directory.
3. Enter the following command:

$TOP/bin/importCompanyFromZip.sh --company_code=IBMPMQ --zipfile_path=/opt/IBM/PMQ/IBMPMQ.zip

56 IBM Predictive Maintenance and Quality Version 1.0: Installation Guide



Error installing IBM Cognos BI in IBM Predictive Maintenance and
Quality

The IBM Cognos Business Intelligence installer requires a specific library file in
order to run.

For information about the problem and the resolution, see the IBM support page
(http://www.ibm.com/support/docview.wss?uid=swg21612290).

Administration tool and product portal reference
The administrative tools and portals for IBM Predictive Maintenance and Quality
are located in several locations.

Access information for the tools and portals is provided in the following table.

Table 21. Administration tool and product portal reference

Administration tool or portal
and description URL or location

WebSphere Integrated
Solutions Console

The WebSphere Integrated
Solutions Console is the
administration tool for
WebSphere.

The WebSphere Integrated
Solutions Console is running
on each node computer where
WebSphere is installed.

Use the console to start and
stop applications.

http://server_node_name:9060/ibm/console

Where server_node_name is the name or IP address of a
node computer where WebSphere is installed.

Leave the User ID box blank.

IBM Cognos Configuration

Use IBM Cognos
Configuration to configure
settings for IBM Cognos
Business Intelligence.

/opt/IBM/cognos/c10_64/bin64/cogconfig.sh

IBM Cognos Configuration is installed on the Business
Intelligence (BI) node computer.

IBM Cognos Connection

Use IBM Cognos Connection
to access reports.

IBM Cognos Administration

Use IBM Cognos
Administration to configure
IBM Cognos BI, such as add
data source connections and
set security.

http://bi_node_name/ibmcognos

Where bi_node_name is the name or IP address of BI node
computer.
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Table 21. Administration tool and product portal reference (continued)

Administration tool or portal
and description URL or location

IBM SPSS Collaboration and
Deployment Services
Deployment Manager

Use IBM SPSS Collaboration
and Deployment Services
Deployment Manager to
configure IBM SPSS server
settings.

http://analytics_node_name:9080/config

Where analytics_node_name is the name or IP address of
Predictive Analytics node computer.

The default user name is admin.

The default password is admin.

IBM InfoSphere Master Data
Management Collaboration
Server

http://mdm_node_name:7507

Where mdm_node_name is the name or IP address of Master
Data Management (MDM) node computer.

The default user name is Admin. This value is case
sensitive.

The default password is trinitron. This value is case
sensitive.

You must also enter a company name. The default
company name is IBMPMQ.
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of

Microsoft Corporation in the United States, other countries, or both.
v Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,

Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

v Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

v Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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